Unpublished Report

<table>
<thead>
<tr>
<th>Document ID:</th>
<th>SheepCRC_6_4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title:</td>
<td>Precision Sheep Management Glovebox Guide</td>
</tr>
<tr>
<td>Author:</td>
<td>Coupland, M.; Pope, C.; Richards, J.; Atkins, K.D.</td>
</tr>
<tr>
<td>Key words:</td>
<td>sheep; precision management; glovebox guide; eID</td>
</tr>
</tbody>
</table>

This report was prepared as part of the Sheep CRC Program 2007-2014. It is not a refereed publication. If the report is quoted it should be cited as:

Sheep CRC Report 6_4
Precision Sheep Management

How to measure and manage sheep to harness individual merit.
Introduction

Precision Sheep Management (PSM) is based on the concept of measuring and identifying animals on merit to lift flock productivity.

This booklet is designed to be a starting guide for producers who appreciate the benefits available and want to implement PSM. It is not designed to be a definitive user-guide to every available method of data capture but contacts provided in the guide can provide information on additional and advanced options. The guide is a collection of proven methods that allow accurate and timely data collection which can then be used to assist in informing management and selection decisions.

The procedures cover the major classes of data:

Fleece data - collecting fleece weight, diameter, wool classing data in the shearing shed

Weigh/reproductive data - collecting liveweight, fat/condition/frame score, reproductive data in the sheep yards

Visual Classing scores such as conformation, quality, fleece rot, breech score in the sheep yards

Methods of data collection available are:

1. Using a weighing device (Tru-Test, Ruddweigh) to record directly into a weighing indicator.
2. Using a computer (hand held, laptop, or desktop) as a data collector to directly record data is more complex but more flexible.
   - Allows multiple scores to be collected
   - Allows less structured data collection and/or recall
   - Enables recollection of previous records at the time of scoring
   - Provides voice activation option

This guide deals with the most basic level of data collection and the most common hardware. While computer assisted data collection options are possibly more varied, most software programs come with their own specific instructions for use.
The opportunity
**The opportunity**

Understanding the variability that exists within a flock provides a platform from which to select the most productive sheep.

**Variability within a Merino flock**

<table>
<thead>
<tr>
<th>Trait</th>
<th>Production level of flock</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Average</td>
<td>Top 25% (by trait)</td>
</tr>
<tr>
<td><strong>Wool traits</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fleece weight (kg)</td>
<td></td>
<td>4.6</td>
<td>5.3</td>
</tr>
<tr>
<td>Fibre diameter (µm)</td>
<td></td>
<td>20.4</td>
<td>18.9</td>
</tr>
<tr>
<td>Staple strength (N/ktex)</td>
<td></td>
<td>35</td>
<td>42</td>
</tr>
<tr>
<td><strong>Meat traits (crossbred lambs)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Growth rate (grams/day)</td>
<td></td>
<td>284</td>
<td>357</td>
</tr>
<tr>
<td>Fat depth (mm)</td>
<td></td>
<td>10.6</td>
<td>8.9</td>
</tr>
<tr>
<td><strong>Reproduction</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lambs weaned per ewe joined</td>
<td></td>
<td>0.86</td>
<td>1.43</td>
</tr>
<tr>
<td><strong>Profitability traits</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fleece value ($) per ewe by wool flock</td>
<td></td>
<td>$54</td>
<td>$82</td>
</tr>
<tr>
<td>Carcase value ($) per ewe by meat flock</td>
<td></td>
<td>$33</td>
<td>$56</td>
</tr>
</tbody>
</table>

Source: Atkins, Richards and Semple 2006
Implementing a Precision Sheep Management system

Implementing PSM is relatively straight forward. Capital investment and significant practice change is required for most producers. It is essential to know which sheep in the flock contribute to enterprise profit. This involves measurement of the basic characteristics that determine value such as fleece-weight, fibre diameter and body weight. These parameters are easy and cheap to measure.

- Radio Frequency Identification (RFID) make collection of data easier, less labour intensive and more accurate.
- RFID tags also allow easy re-use of data throughout the life of the animal and facilitate automatic drafting and more sophisticated management techniques.
- Automated data entry, data management and decision support systems are available for practically all aspects of PSM and are becoming more powerful and easier to use.
- Automatic drafting using RFID with decisions based on an index, or a single parameter, allows precise management of culling, joining and marketing. Automatic drafting systems responding to computer lists or real time weights, are becoming robust, cost effective management tools.

Advanced features of PSM include continuous or regular weight monitoring and remote drafting systems that respond to weight change and/or indexed instructions. These systems used together hold potential for precise administration of nutrition to animals in need, early detection of parasite and health problems, management of wool quality and lamb survival.
Your options

10 years from now
What progress is possible on an individual flock basis? Realistic production scenarios demonstrate the potential benefits of PSM.

1. Most commercial Merino flocks consider the process of basic genetics through selection. Average grade rams are brought from a recognised ram source and the average industry rate of genetic gain is anticipated.

2. By improving ram selection through choosing enhanced genetics from available data, accelerated genetic gain can be achieved. Superior rams are purchased from one or more ram sources using breeding values supplied through Sheep Genetics and a selection index that reflects an individual commercial breeding objective is implemented on farm.

3. By using additional measurement and management processes – PSM – within the flock additional value can be extracted through breeding and selection of replacement ewes (and wethers), optimising flock structure and obtaining market advantage through better meeting specifications. The precision strategy can be applied to both basic and enhanced genetics models.

Point to note
Enhanced genetics and PSM are complementary, not mutually exclusive.
# Fine wool production system

Features of the specialist fine wool flock and strategies for improvement

<table>
<thead>
<tr>
<th>Current production level:</th>
<th>Future production determined by:</th>
</tr>
</thead>
<tbody>
<tr>
<td>18.5 µm adult wool</td>
<td><strong>1</strong> Basic genetics:</td>
</tr>
<tr>
<td>2000 breeding ewes</td>
<td>Average industry gains of +2%, -0.7µm and +.8kg in fleece weight, fibre diameter and body weight respectively over 10 years</td>
</tr>
<tr>
<td>- 5 age groups</td>
<td><strong>2</strong> Enhanced genetics:</td>
</tr>
<tr>
<td>1000 adult wethers</td>
<td>Genetic gains of +2.6%, -1.0µm and +1.2kg over 10 years and between-flock effects of +5%, -0.15µm and +1.5kg in fleece weight, fibre diameter and body weight respectively, delivered through selection based on a Fine 10% Sheep Genetics (SG) index</td>
</tr>
<tr>
<td>- 3 age groups</td>
<td><strong>3</strong> PSM:</td>
</tr>
<tr>
<td>75% reproduction rate</td>
<td>Select replacement ewes and wethers on measured fibre diameter</td>
</tr>
<tr>
<td>Surplus animals sold @ 18 months ($40 per head value)</td>
<td>Optimise age structure and relative flock sizes of ewes and wethers</td>
</tr>
<tr>
<td></td>
<td>Clip preparation using measured diameter</td>
</tr>
</tbody>
</table>

Example
# Medium wool production system

Features of the specialist medium wool flock and strategies for improvement

<table>
<thead>
<tr>
<th>Current production level:</th>
<th>Future production determined by:</th>
</tr>
</thead>
<tbody>
<tr>
<td>20.5 µm adult wool</td>
<td>1 <strong>Basic genetics:</strong></td>
</tr>
<tr>
<td>3000 breeding ewes</td>
<td>Average industry gains of +4%, -0.6µm and +1.5kg in fleece weight, fibre diameter and body weight respectively over 10 years</td>
</tr>
<tr>
<td>- 4 age groups</td>
<td>2 <strong>Enhanced genetics:</strong></td>
</tr>
<tr>
<td>No adult wethers</td>
<td>Genetic gains of +5%, -0.8µm and +2.2kg over 10 years and between-flock effects of +5%, -0.25µm and +2.0kg in fleece weight, fibre diameter and body weight respectively together with a +1% increase in reproduction rate, delivered through selection based on a Merino 7% Sheep Genetics (SG) index.</td>
</tr>
<tr>
<td>80% reproduction rate</td>
<td></td>
</tr>
<tr>
<td>Surplus animals sold @ 15 months ($40 per head value)</td>
<td>3 <strong>PSM:</strong></td>
</tr>
<tr>
<td></td>
<td>Select replacement ewes on measured fibre diameter and fleece weight in an index.</td>
</tr>
<tr>
<td></td>
<td>Test for selecting wethers on measured fibre diameter</td>
</tr>
<tr>
<td></td>
<td>Optimise age structure and relative flock sizes of ewes (and wethers)</td>
</tr>
<tr>
<td></td>
<td>Clip preparation using measured diameter</td>
</tr>
<tr>
<td></td>
<td>Sell surplus animals reaching 48kg as Merino lambs prior to 12 months of age – the remainder sold at 15 months</td>
</tr>
</tbody>
</table>
# My PSM plan

Before committing to implementing a PSM system it is important that you understand your current position, have a clear and realistic picture of what you want your flock to look like – we suggest 10 years hence – and know how you are going to achieve your objective. Part of achieving your objective will be understanding the areas in which you will need assistance. Take some time to document how you plan to implement PSM on your farm.

<table>
<thead>
<tr>
<th>Fibre diameter</th>
<th>Where do I want to be in 10 years?</th>
<th>What do I need to do?</th>
<th>Who do I need to talk to?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fleece weight</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Body weight</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reproduction</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other traits</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hardware</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Software</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other considerations</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Setting up for weighing

Using RFID devices to assist with data collection is one method of enhancing PSM. The technology makes data capture of repeated records across years much easier and more accurate. Equipment requirements depend on the level of recording required.

**Equipment required:**
1. RFID tags for each animal
2. A RFID reader (hand held stick or fixed panel)
3. Load cells
4. A data collector (data logger or indicator, computer or hand held)
5. A computer program for data download (or upload) for review and/or analysis

<table>
<thead>
<tr>
<th>RFID tag types</th>
<th>Usage</th>
<th>Read Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>FDX-B</td>
<td>Single animal recording sessions (eg. weighing in crate, classing, fleece weighing) Effective where the animal is confined and the read range and sheep flow is restricted.</td>
<td>5 – 15 cm</td>
</tr>
<tr>
<td>HDX</td>
<td>Can be used for the same functions as above, but are better at multiple animal recording sessions (eg. walk over weighing, pedigree matching, roll call events) because of the longer read range.</td>
<td>11 – 24 cm</td>
</tr>
</tbody>
</table>

**Top tip:**
These read range figures are based on read range bench testing undertaken at Orange NSW, using an Allflex Grey stick reader. The figures quoted are the average for reads in best orientation (and worst orientation), based on 50 tags of 11 different types, from five separate manufacturers. The read ranges would be greater if a panel reader had been used.
## What does it cost?

<table>
<thead>
<tr>
<th>Equipment required</th>
<th>Approximate Cost ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load cells</td>
<td>1,000 - 1,200</td>
</tr>
<tr>
<td>Weighing indicator</td>
<td>1,400 – 3,400</td>
</tr>
<tr>
<td>RFID reader – stick</td>
<td>1,300 – 2,000</td>
</tr>
<tr>
<td>RFID reader – panel</td>
<td>2,400 – 3,800</td>
</tr>
<tr>
<td>Barcode printer</td>
<td>1,000 – 3,000</td>
</tr>
<tr>
<td>Barcode scanner</td>
<td>300 – 400</td>
</tr>
<tr>
<td>Manual weigh crate</td>
<td>1,000 – 2,000</td>
</tr>
<tr>
<td>Automatic weigh/drafter</td>
<td>10,000 – 30,000</td>
</tr>
<tr>
<td>RFID tags</td>
<td>1.50 – 2.50 each</td>
</tr>
</tbody>
</table>

### Top tip:

Greater selection pressure increases the speed of genetic gain. A 10% increase in weaning percentage can lift profit per hectare by 13-21% in first-cross enterprises and 14-24% in Merino breeding operations.
Three basic options for PSM

1. **Fleece weighing** – collecting fleece weights and other fleece data in the shearing shed.
2. **Body weighing** – collecting live animal weights (either manually or automatically) and other associated body traits (fat score, frame score) in the sheep yards.
3. **Visual classing** – collecting visual trait scores (e.g., size, wool quality, fleece rot, frame etc) in the sheep yards.

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Fleece weighing</th>
<th>Body weighing</th>
<th>Visual classing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weigh bars</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>RFID tags (lambs)</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>RFID tags (ewes)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Panel/stick reader</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Weigh indicator data logger/computer</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Drafter (auto/manual)</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Barcode reader</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Barcode printer</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

**Methods of data collection**
1. Using a weighing device data collector (Tru-Test, Ruddweigh) to record data directly into indicator.
2. Using a computer (hand held, laptop or desktop) as the data collector to directly record data.

**Top tip:** It is imperative that all hardware is checked and functional (ensuring that all batteries are charged) at least 24 hours prior to use. After two sheep records have been taken check to ensure data file is being created, and data is recorded for all traits entered. Following these steps will ensure that you have a robust process for file saving and data backup, the data file has been created and records are correctly stored.
Fleece weighing
Fleece weighing

Equipment required:
- Load cells
- Weighing indicator
- RFID reader/stick
- Barcode printer
- Barcode scanner

Process

1. Turn on printer and stick reader. Allow Bluetooth® pairing.
2. Scan animal RFID tag and print barcode label. If more than one label is required scan the tag an appropriate number of times.
3. Barcode goes with fleece to weigh station.
4. Place fleece on scale, scan barcode into weighing indicator.
5. Press weigh button to capture fleece weight.
6. Add extra data (binline, style etc) as required.

* If using Bluetooth® devices see section below on configuring & pairing Bluetooth®
Option 1

Collecting fleece weights using Tru-Test indicator and a barcode scanner

**Equipment required:**
- Tru-Test indicator (model XR3000) ①
- Fleece weighing pan and load cells ②
- Barcode scanner ③ and printer
- Stick reader

*Image 1. Tru-Test indicator and barcode scanner*
Option 1 cont...

Collecting fleece weights using Tru-Test indicator and a barcode scanner

Process

1. Plug two leads from weigh bars into Tru-Test indicator (see Image 1, *previous page*).
2. Plug serial cable from barcode scanner into comm port 2 in TruTest indicator (see Image 1, *previous page*).
3. Plug lead from scanner into power supply (see Image 1, *previous page*).
4. Turn Tru-Test indicator on and open file to save data in
   - File (pick a file or choose empty file and rename)
   - Setup ➔ System ➔ Weight recording ➔ auto (captures weight automatically)
     or manual (must press button to capture weight) (recommended)
   - Setup ➔ System ➔ Resolution ➔ (how accurate do you want weight measurements, Usually 0.1kg)
   - Setup ➔ System ➔ Auto Zero Track ➔ Off
5. Turn on stick reader and Bluetooth® printer and allow to pair.
6. Scan RFID tag to print barcode.
7. Put wool on scales.
8. Scan barcode of ear tag (can also scan before weighing with TruTest indicator).
9. Can also store one other trait (eg. bin line).
   - a. Setup ➔ tick code 1, code 2 or code 3 on RHS to select extra fields to score (Can rename code to bin lines).
     Once the wool has been weighed (red light comes on Tru-Test indicator) type in bin line and press enter.
   - b. Setup ➔ file data ➔ under label type or select bin line ➔ turn on.
10. After weighing, to view files;
    - a. File ➔ (choose your file) ➔ Esc.
    - b. File data ➔ (will show records).
       Stats ➔ (shows how many animals, average, max, min and SD of animals recorded).
Option 2

Collect fleece weights using Ruddweigh and a barcode scanner

Equipment required:
- Ruddweigh indicator (model 600, 700, 800)
- Fleece weighing pan and load cells
- Barcode scanner and printer
- Stick reader

Image 2. Barcode scanner

Image 3. Ruddweigh indicator
Option 2 cont...

Collect fleece weights using Ruddweigh and a barcode scanner

Process

1. Plug serial cable from barcode scanner into Ruddweigh indicator (Image 3).
2. Plug leads from weigh bars into Ruddweigh indicator.
3. Plug lead from scanner into power supply (Image 3).
4. Turn dial to 'S' → Session menu → Session (Select 'name' to name a new file or 'select' to choose file with previously collected data in it).
5. Turn to 'M' (Manual - will need to press button to capture weight) or 'F' (Fine – takes longer to get more precise result).
6. Turn on stick reader and Bluetooth® printer and allow to pair.
7. Scan RFID tag to print barcode.
8. Put fleece on scales.
9. Scan barcode and press green weigh button to record.
10. Use score to record bin line.
11. After weighing, to view files:
   • Select session menu → Select session to look at → View → Select (use arrow keys to view).
Problem solving

Reconfiguring Allflex stick reader for Bluetooth® dongle

Bluetooth® technology is a wireless connection that allows signals or data to be sent from one device to another without the use of cables. The system relies on one device being the ‘master’ (which sends a signal) and the other the ‘slave’ which is waiting to connect to its ‘master’. This connection is called ‘pairing’, and after it is made data can be sent from one device to the other.

To allow use of an Allflex RS320 stick reader with a Bluetooth® barcode printer, the devices must be ‘paired’ to enable communication between the correct machines.

Image 4 shows one possible combination of RFID reader and Zebra QL 320 printer, using Bluetooth® to send RFID number from reader to printer.

When the printer is powered-up the internal Bluetooth® device switches on, waiting for pairing with another Bluetooth® device. The Bluetooth® reader can only be paired with one device at a time, so the reader can be set up to automatically pair with the barcode printer. If the reader needs to be paired to a different device a configuration program has to be run, to tell the reader which device to connect with, when it next starts.

Image 4. Allflex RS320 stick reader and Zebra QL 320 printer
Problem solving

Reconfiguring Allflex stick reader for Bluetooth® dongle

Not configured correctly?
If the Bluetooth® dongle is not configured correctly, try the following method to pair the dongle to the reader. If using another type of reader, contact the manufacturer for pairing instructions.

1. Obtain copy of Allflex stick reader configurator program as supplied with reader.
2. Install program on a computer, attach serial lead from comm port (1-4) of computer to the reader using the flexible data/power cable and screw-on end cap as supplied with the reader.
3. Click button, to Get Settings from reader
4. The first settings screen should look like image 5, which shows information about Operational settings. For Bluetooth® operation ensure power is Always On.

![Image 5. Operational settings](image5.png)
Problem solving cont...

Reconfiguring Allflex stick reader for Bluetooth® dongle

Not configured correctly?

5. The next image (Image 6) shows ID-Code Format of the tags that are read. These settings can be altered to send the tag in the correct format for the particular job, in this case: XXX_ NNNNNNNNNNNN where XXX is the tag manufacturer followed by a space then NNNNNNNNNNNN, the 12 digit RFID number.

Image 6. ID-Code Format of the tags
Problem solving cont...

Reconfiguring Allflex stick reader for printer

6. The next image (Image 7) shows the Bluetooth® configuration.

The settings mean

• Power module on - turn on reader Bluetooth® cap.
• Connection Mode - stick will be the 'master'.
• Pairing – Slave ID - the 12 digit address identity of the device to be paired. This can be printed by going into the printer setup mode (hold down the form feed key while pressing the ON button), and the printers’ system settings will print out. One of these settings will be the Bluetooth® address.
• RF Channel and Power settings should not be altered.

Image 7. Bluetooth configuration
Problem solving cont...

Reconfiguring Allflex stick reader for printer

7. After making the required settings changes please ensure that the Apply Settings (or F3 function key) is pressed to allow these settings to be stored into the tag readers’ memory.
8. Connect the Bluetooth® end cap to the reader, when the stick reader is next turned on, the Bluetooth® module will be configured to pair with for the printer bluetooth address as per the configuration.

Top tip:
This sometimes requires the reader to be turned on and off a couple of times for the link to be established. Also ensure the printer is turned on.

After the initial pairing, every time the reader is turned on (if the printer has power to it) the connection will be automatically established. Follow these steps to establish link:
1. Turn printer on.
2. Turn stick reader on (press green button), small Bluetooth® icon on LCD panel will change from open icon (Image 8b) to closed icon (Image 8a) to indicate the connection is active.

Top tip:
If the reader or printer loses power the Bluetooth® link will be lost. Change the reader battery or connect the printer to power, turn on both devices, and the link will re-establish.
Troubleshooting

If Bluetooth® link fails between devices:
• Ensure both devices are powered-up.
• Check Bluetooth® address in the configuration program to ensure it is typed in correctly.
• Ensure connection in the configuration program, is made with the stick reader as master and dongle as slave.
• Ensure power mode and device pairing in the configuration program, are both turned ON.
• Ensure Apply Settings has been activated.

Top tip:
If Bluetooth® link is established between the stick and the dongle but RFID numbers are not scanned check the configuration of the dongle. To do this, obtain a copy of the Free2move configuration software (from Allflex or from the internet). Connect the dongle (via the special cable) supplied and check that serial port settings are 9600, n, 8, 1. If an incorrect setting exists the device will not be able to communicate with the reader, regardless of the link being made.
Manual sheep weighing
Manual sheep weighing

Equipment required:
- Manual weigh crate
- Load cells
- Weighing indicator
- RFID reader/stick

Process
1. Animal enters crate.
2. Scan animal RFID tag.
3. Press weigh button to capture (possibly automatic).
4. Add extra data (fat score/condition score, comments, etc) as required.
5. Release animal.
Collecting body weights using a stick reader for individual ID

Option 1

**Equipment required** –
- Allflex stick reader ①
- Tru-Test indicator (model XR3000) ②
- Load cells ③ and weigh crate

*Image 9. Tru-Test indicator, stick reader and weigh bars*
Collecting body weights using a stick reader for individual ID

Option 1 cont...

**Process**

1. Plug two leads from load cells into Tru-Test indicator.
2. Plug Bluetooth® adaptor into com2 port in Tru-Test indicator.
3. Turn Tru-Test indicator on and open file to save data in.
   - File ➞ (pick a file or choose empty file and rename)
   - Setup ➞ System ➞ Weight recording ➞ Auto (captures weight automatically) or manual (must press button to capture weight)
   - Setup ➞ System ➞ Resolution ➞ (How accurate do you want weight measurements?)
   - Setup ➞ System ➞ Auto Zero Track ➞ On
   - Turn stick reader battery on. Ensure stick reader is face-up.
4. Put animal on scales.
5. Scan ear tag – Press button on stick reader and aim end of stick at tag (can scan before weighing with Tru-Test indicator).
6. Can also store one other trait (eg. Condition score).
   - Setup ➞ File data ➞ Under label select condition score or rename as condition score ➞ Turn on.
   - Once the animal has been weighed (red light comes on Tru-Test indicator) type in condition score and press enter.
7. After weighing, to view files:
   - File ➞ (choose your file) ➞ Esc
   - File data ➞ (will show records)
   - Stats ➞ (shows how many animals, average, max, min and SD of animals recorded)

**Top tip:**

If older style grey reader, ensure the button is not depressed as battery is turned on.
If this happens the reader will revert to default settings.
Collecting body weights using a stick reader for individual ID

Option 2

Equipment required:
- Ruddweigh indicator (model 800)
- Load cells
- Syscan Bluetooth® wand

Process
1. Plug leads from weigh bars into Ruddweigh indicator.
2. Plug Bluetooth® adaptor into Ruddweigh indicator.
3. Turn Ruddweigh indicator on and open file to save data in.
   - Turn dial to 'S' (setup) ➔ select session menu ➔ session ➔ choose 'name' to name a new file or choose 'select' to choose from files with previous data in it.
4. Turn dial to 'A' to weigh automatically - See Ruddweigh manual for 'M' and 'F' settings.
5. Turn reader on and wait for Bluetooth® connection to pair.
6. Put animal on scales.
7. Scan ear tag – Press button on stick reader and aim end of stick at tag – stores all 16 numbers even though it only displays 4 (can scan before weighing with Ruddweigh indicator).
   Can also store one other trait (eg. condition score).
   Press score (will bring up extra box on Ruddweigh screen) ➔ Press number ➔ Enter
8. After weighing, to view files: Select session menu ➔ Select session to look at ➔ View ➔ Select (use arrow keys to view).
Automatic weighing & drafting
Automatic weighing & drafting

Equipment required:
- Automatic weigh crate
- Load cells
- Weighing indicator
- RFID reader/panel

Process
1. Animal enters crate.
2. Scan animal RFID tag.
3. Weight automatically captured.
4. Add extra data (Fat score/condition score, comments, etc) as required.
5. Animal automatically drafted and released.
Option 1

Equipment required:
- Prattley auto drafter
- Tru-Test indicator (model XR3000)
- Edit ID reader
- Load cells

Process
1. Place the Tru-Test indicator and EditID reader on the appropriate stands (Image 10).
2. Plug grey cord into com1 serial port (9 pins) in Tru-Test indicator (Image 11) and attach other end to Prattley auto drafter (4 pins) (Image 13).
4. Plug the two blue leads (from weigh bars) into Tru-Test indicator (either lead in either plug) (Image 11).
5. Turn Tru-Test indicator on.
6. Attach power cable from EditID reader (Image 12) to 240V power source (can use battery if power unavailable).
7. Bolt panel reader onto near side of scales (needs to be removed for transporting).
8. Attach reader cable (from panel reader) to EditID reader in antenna port 1 (Image 12).
9. Turn power on to EditID reader – if red light is not on, power is not on.
Option 1 cont...

Process cont...

10. Attach air hose from compressor to air control module (Image 13).
11. Attach air control module on drafter (orange cord) (Image 13) to battery.
12. Replace remote batteries (should remove when not in use). If batteries flat, use remote with cable.
13. Set up Tru-Test indicator for auto drafting:
   Make initial selection using softpad keys (Image 11), select what needs to be changed using the arrow keys.
   Press enter to view the range of options. Choose correct option using the arrow keys. Use Esc or back key to go back.
   • File ➤ (pick a file or choose empty file and rename)
   • Setup ➤ Draft
   *Drafting ➤ turn on (choose tick
   *Draft by ➤ (select field – usually weight)
   *Draft range ➤ (set draft limits for each gate) eg. 1. 0-35kg
       2. 36-45kg
       3. 46-65kg
   • Setup ➤ System ➤ Weight recording ➤ Manual (must always be set to manual NOT auto)
   • Setup ➤ System ➤ Resolution (usually 0.5kg) ➤ (How accurate do you want weight measurements?)
Option 1 cont...

Process cont...

14. Set up Prattley auto drafter (Image 13):
   Mode: Auto
   Crate: Other (NOT sheep or cattle)
   High/Med/Low: set direction animals are to be drafted

15. Press any remote control button once to open gates and once again to close gate after animal enters. Once weight has been recorded
   the gates will open according to which group the animal has been allocated to (set in draft range). If opening manually, hold down
   arrow according to which gate you want opened.

16. If fat score needs to be recorded as well as weight, select Setup and turn on Fscore (choose tick or select a code field).
   Once animal has been weighed (red light comes on Tru-Test indicator) determine fat score, type into Tru-Test indicator and press enter.

17. After weighing, to view files;
   • File → (choose your file) → Esc
   • File data → (will show records)
   • Stats → (shows how many animals, average, max, min and SD of animals recorded
   • Stats → Draft → (shows the statistics for animals in each drafted group).

Image 14:
Remote control for drafter
Option 2

Equipment required:
• Ruddweigh auto drafter
• Ruddweigh indicator
• Load cells
• Reader

Process
1. Attach leads from reader to indicator.
2. Attach lead from drafter controller to indicator.
3. Connect air hose from compressor.
4. Turn on Ruddweigh box.
   - Go to Settings → Communications and set.
   - a. Port 1 – Drafter Special.
   - b. Port 2 – EID Allflex.
5. Turn on RFID reader and Drafter control box.
6. Press and hold Button 4 on hand control to open rear gate. After animal enters, release button to close rear gate.
7. Tag will by read by reader and sent to weighing indicator box. After a stable weigh is captured, the front gate will be automatically release the sheep.
8. If drafting by weight go to Setup → Draft to turn drafting on and set weight limits for drafting.
9. After weighing, to view files; Select session menu → Select session to look at → View → Select (use arrow keys to view).

Top tip:
Use manual weighing if you want to add condition score or comments (this means the GREEN weigh button must be pressed to capture weight and comments). If you want to record fat or condition score press score, enter value, green button.
Collecting visual classing scores

Option 1

Equipment required:
- Tru-Test XR3000 indicator
- Allflex reader
- Load cells if weighing

Process
1. If weighing, plug leads from weigh bars into Tru-Test indicator.
2. Plug Bluetooth® adaptor into com2 port in Tru-Test indicator.
3. Turn Tru-Test indicator on and open file to save data in:
   - File ➔ (pick a file or choose empty file and rename)
   - Setup ➔ System ➔ Weight recording ➔ Manual (must press button to capture weight)
   - Set up fields to collect visual scores, either rename fields in Setup ➔ Filedata or use pre-named fields Code 1, Code 2 etc.
4. Turn stick reader battery on.
5. Put animal on scales.
6. Scan ear tag into indicator.
7. Enter trait scores (eg. Code 1, Code 2 as required). Press Weigh button to capture weight and record scores.
8. After weighing, to view files:
   - File ➔ Choose your file) ➔ Esc
   - File data ➔ (Will show records)
   - Stats ➔ (Shows how many animals, average, max, min and SD of animals recorded).
Collecting visual classing scores

Option 2

Process
- Ruddweigh 800 indicator
- Syscan reader
- Load cells if weighing

With the Ruddweigh 800 this is a 2 step process.

Step 1. Build the scoring template
1. In MyScale Pro go to Configure Trait Custom Table.
2. Enter the number of traits to be scored (in the example at right there are 8 fields).
3. Enter the label to be displayed for each field (i.e. the trait name).
4. Select the maximum number of characters allowable for that score. NB. The more characters allowed for any one field the less number of fields possible.
5. Click OK to save the new trait table and follow the prompts to upload the table to the indicator.
Collecting visual classing scores

Option 2 cont...

Step 2. Select the trait table then commence scoring

1. If weighing, plug leads from weigh bars into Ruddweigh indicator.
2. Plug Bluetooth® dongle into Ruddweigh indicator.
3. Turn Ruddweigh indicator on and open file to save data in.
   • Turn dial to 'M' to weigh manually
4. Turn reader on and wait for Bluetooth® connection to pair.
5. Click soft key button for NEW.
6. Click soft key button for TRAIT, this will load the previously uploaded Custom Trait table, then click OK to continue.
7. Put animal on scales or in classing box.
8. Scan ear tag, then press ENTER, the list of traits from the table are displayed on the bottom of screen.
9. Enter the score for the trait (cursor drops to the next field after data entry).
10. Press GREEN button to record weight and scores.
11. After weighing, to view files; Select session menu ➔ select session to look at ➔ view ➔ select (use arrow keys to view).
Downloading and uploading data
Download from Gallagher 700/800

Process

1. If not already installed, install the **MyScale Pro** program from the Installation CD.
   If no CD or need a newer version, contact your nearest Gallagher representative for a new CD.

2. Connect a serial cable from a Comm Port on the indicator to a serial port on your PC.

3. Turn on the indicator and ensure that Comm Port 1 on the indicator is set to Computer (See Setup; Communications; Port 1).

4. Open the MyScale Pro program and it should automatically connect.

5. Click “Copy sessions from scale to computer” on front screen and then click next.

6. Click the option for copying files to computer (Image 16).
   a. Copy **ALL** sessions (all sessions on the indicator).
   b. Copy **NEW/UPDATED** session (only new or updated sessions are copied).
   c. Copy **DRAFT LIST** session (copy a new drafting list onto indicator).

Image 16. My Scale Pro copying files
Downloading from Gallagher 700/800

**Process**
7. Click **NEXT** to begin download.

**Top tip:**
In the screenshot (Image 17) an error message is displayed because there was no indicator connected to the computer, in normal circumstances, with the correct cables and settings this message will not appear.
After the files are downloaded, you can then open them in either the **MyScale Editor** or locate the CSV file and open with MS Excel®.

*Image 17. Error message*
Uploading to Gallagher 700/800

Process
1. Create a new file in the MyScale Editor.
2. Copy RFID, Visual Id and any notes you might want to display into this editor file.
3. Save the file and exit editor window.
4. Upload newly edited file into the indicator.

To do this:
1. Open the MyScale Pro program.
2. Connect a serial cable from a Comm Port on the indicator to a serial port on your PC.
3. Turn on the indicator and ensure that Comm Port 1 on the indicator is set to Computer (See Setup; Communications; Port 1).
4. Open the MyScale Pro program and it should automatically connect.
5. Click “Copy SELECTED sessions to the scale” then click Next.

Any new tag information (either visual, RFID or notes) is written into the Lifedata table for future use, so that when an RFID is read, the indicator matches the visual id and displays the number on screen (provided this option is turned on).
Uploading to Gallagher 700/800

**Top tip:**
If setting up for auto-drafting ensure that Comm Port 1 on the indicator is set to Drafter Special otherwise drafter will not receive signal from indicator and gates will not swing (See Setup; Communications; Port 1).
Consult the *MyScale Pro* instruction manual for more clarification of any of these processes. Any new tag information (either visual, RFID or notes) is written into the Lifedata table for future use, so that when an RFID is read, the indicator matches the visual id and displays the number on screen (provided this option is turned on).

*Image 19 Copying files from computer to scale*
Downloading from Tru-Test XR3000

Process

1. If not already installed, install the Link3000 program from the Installation CD. If no CD or need a newer version, login to http://www.trutest.co.nz/weighing_new/ and click the Download option. Select Link3000 software and the installation files will be downloaded to your PC.

2. Connect the Null Modem cable from a Con Port (connector port) on the indicator to a serial port on your PC.

3. Turn on the Tru-Test indicator.

4. Open the link program and it should automatically connect.

5. Select "Selected File" on front screen and then choose which file you want to download via the drop down menu (click the small down arrow tab on the right hand side and scroll to the desired file).
Downloading from Tru-Test XR3000

Process

6. Choose the directory where you want the data to download (by using the “Browse” button) or leave the download directory as is, and note the directory name.

7. Press “Download”. The file should automatically open an MS Excel® sheet and place the data in it. To turn on/off automatic file opening, click Setup button, and tick/untick box beside “open selected file after download”. The box on the right hand side displays the data being downloaded line by line, until the download is complete.

Top tip:
If any changes are made, make sure you then save this file!
Uploading to Tru-Test XR3000

Process

1. Create a new file in the XR3000 indicator, with all the relevant data fields switched on. For example, if you wanted to record RFID, view Visual ID, capture a weight and enter Fat Score, you would have to turn on the required fields from the “Setup” screen in the indicator.

2. Manually enter a tag number into the indicator, and press “Enter” so that a record is created.

3. Connect the XR3000 indicator to the PC using the Null Modem cable.

4. Download the newly created file to the PC (following steps on previous page).

5. Open the file you downloaded and delete all data under the headings.
   (NB ensure that the headings are not deleted, as the file will not correctly upload if there is a heading conflict).

6. Copy RFID and Visual ID (or whichever fields you may want to display) into this file.

7. Upload newly edited file into the Tru-Test indicator.

   To do this:
   1. Open the link 3000 program.
   2. Select “Setup”.
   3. Select “Upload files to indicator”.
   4. Click “OK”.
   5. Use the browse menu to select the file that you want to upload.
   6. Press “Upload”.
   7. The program will ask if you want to overwrite the previous version (the version with only 1 record) with the new data.

Top tip:
New tag information (either visual or RFID) is written into the lifedata table for future use, so when an RFID is read, the indicator matches the visual id and displays the number on screen (provided this option is turned on).
If different information (say sire or group) is required in the indicator, it is often useful to delete the previous tag entries and update all the relevant Lifedata entries, to avoid confusion. Ensure you have backups of the lifedata table before doing this operation.
Consult the Tru-Test instruction manual for more clarification of any of these processes.
Software tools for PSM
Software tools for PSM

There are 2 sorts of tools available:
- Those based on models (decision support tools) that can help set objectives and visualize the progress that can be made and;
- Those that rely on the input of individual data (operational tools) and that inform management decisions.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Purpose</th>
<th>Key input variables</th>
<th>Key output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection Assist</td>
<td>Predict potential genetic progress using different selection strategies over 5 or 10 year time frame</td>
<td>Current FD, weaning %, wool/meat prices (set prices and discount options), selection strategy</td>
<td>Changes in FD, FW, BW and GM ($/DSE or $/ewe)</td>
</tr>
<tr>
<td>Flock Structure</td>
<td>Optimise number of age classes for breeding ewes and adult wethers given a selection strategy</td>
<td>Current flock structure Production levels Selection strategy Wool/meat prices</td>
<td>Changes in FD, FW, BW and GM ($/DSE or $/ewe)</td>
</tr>
<tr>
<td>Terminal Flock Calculator</td>
<td>Calculates the maximum number of Merino ewes that can be mated to terminal sires without affecting flock structure</td>
<td>Flock structure</td>
<td>Number of ewes mated to terminal sires</td>
</tr>
<tr>
<td>OFFM Calculator</td>
<td>Profitability of using fibre diameter measurement for clip preparation and selection</td>
<td>Flock structure Production levels Cost of on-farm fibre measurement Wool prices</td>
<td>Profitability</td>
</tr>
<tr>
<td>Wether Calculator</td>
<td>Calculates optimum percentage of wethers to run in self replacing merino flock and compares selection methods for the wethers</td>
<td>Flock structure Production levels Meat/wool prices</td>
<td>Changes in FD, FW, BW and GM ($/DSE or $/ewe)</td>
</tr>
</tbody>
</table>
# Software tools for PSM

There are 2 sorts of tools available cont...

<table>
<thead>
<tr>
<th>Tool</th>
<th>Purpose</th>
<th>Key input variables</th>
<th>Key output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operational tools</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Raceside classer</td>
<td>Calculate index value and destination</td>
<td>FW, FD, CV and BW Index</td>
<td>Rank and destination</td>
</tr>
<tr>
<td>Lamb Growth Predictor</td>
<td>Calculate growth rates from repeated body weights to predict future weights and turnoff dates</td>
<td>Minimum of 3 body weights over time</td>
<td>Predicted weights and draft lists</td>
</tr>
<tr>
<td>Simultaneous Assortment</td>
<td>Selects animals most appropriate for wool or meat production from existing flock (or mating group)</td>
<td>Fibre diameter Body weight (Fleece weight)</td>
<td>Selection lists for meat group and wool group animals</td>
</tr>
<tr>
<td><strong>e-stud tools</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pedigree Matchmaker</td>
<td>Assign dam pedigree</td>
<td>Repeat records of RFID tags (ewes and lambs) over time Ewe and lamb tag lists</td>
<td>Matched pedigree report</td>
</tr>
<tr>
<td>Ram Value Calculator</td>
<td>Estimate and compare value of rams in a commercial flock</td>
<td>Flock structure Production levels Ram breeding values Wool/meat prices</td>
<td>Economic and production value of specified rams within flock</td>
</tr>
</tbody>
</table>
Industry contacts
## Industry contacts

### RFID products

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Contact</th>
<th>Phone</th>
<th>Web address</th>
</tr>
</thead>
</table>
| **AgInfoLink Australasia**  
Electronic readers       | Tom Newsome                       | 02 6732 2298  | www.aginfolink.com.au    |
| **Aleis International**  
Electronic readers (NLIS) | Annabel Finlayson                 | 07 4668 5941  | www.aleis.com            |
| **Allflex Australia**    
Electronic tags and readers | Pat Gunston, Arnold de Leon (tech support) | 07 3245 9100, 1300 362 733 | www.allflex.com.au       |
| **Equinox Software**     
Infra Red RFID scanners   | Geoff Farr                         | 07 4939 3107  | www.equinox.com.au       |
| **Gallagher Australia**  
| **Leader Products**      
RFID tags                | Bruce Dumbrell                     | 03 9308 2355  | www.leaderproducts.com.au |
# Industry contacts

## Computer software

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Contact</th>
<th>Phone</th>
<th>Web address</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AgInfoLink Australasia</strong></td>
<td>Tom Newsome</td>
<td>02 6732 2298</td>
<td><a href="http://www.aginfolink.com.au">www.aginfolink.com.au</a></td>
</tr>
<tr>
<td><strong>AgInfoLink’s product suite ranges from Traceability and premises management tools to data collection and reporting tools.</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Allstock Technology</strong></td>
<td>Jane Rindfleish</td>
<td>02 6889 4040</td>
<td><a href="http://www.allstock.com.au">www.allstock.com.au</a></td>
</tr>
<tr>
<td><strong>WoolPak software for sheep data recording. Can use with electronic tags.</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AMAC Pty Ltd</strong></td>
<td>Royden Lake</td>
<td>02 6771 2266</td>
<td><a href="mailto:amacpl@ozemail.com.au">amacpl@ozemail.com.au</a></td>
</tr>
<tr>
<td><strong>Sheep production hand held electronic recording and fleece tracking systems</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Australian Fibre Testers</strong></td>
<td>Lorraine Hewitt, WA</td>
<td>08 9641 2111</td>
<td><a href="mailto:aft@bbnet.com.au">aft@bbnet.com.au</a></td>
</tr>
<tr>
<td>FibreSoft® software for OFFM reporting for both Laserscan and OFDA, selection indexes, progeny testing and clip preparation</td>
<td>David Rolfe, Qld</td>
<td>07 4654 8183</td>
<td><a href="mailto:aft_qld@bigpond.com">aft_qld@bigpond.com</a></td>
</tr>
<tr>
<td><strong>Creative Logististics</strong></td>
<td>Paul March</td>
<td>02 9982 1194</td>
<td><a href="http://www.creativelogistics.com.au">www.creativelogistics.com.au</a></td>
</tr>
<tr>
<td>Product &amp; packaging security plus animal management systems.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Fairport Technologies</strong></td>
<td>Roger Wiese</td>
<td>1800 500 195</td>
<td><a href="http://www.fairport.com.au">www.fairport.com.au</a></td>
</tr>
<tr>
<td>Farm planning, production recording, farm management, mapping and machinery fleet management software.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Hutchinson Software</strong></td>
<td>Chris Hutchinson</td>
<td>02 6775 1988</td>
<td><a href="http://www.hutchinsonsoftware.com">www.hutchinsonsoftware.com</a></td>
</tr>
<tr>
<td>Web, database and e-business custom software solutions.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Contact</td>
<td>Phone</td>
<td>Web address</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>--------------------------</td>
<td>----------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td><strong>Interactive Wool Group (IWG)</strong></td>
<td>Richard Manning, NSW</td>
<td>02 6766 3077</td>
<td><a href="http://www.iwgofda.com">www.iwgofda.com</a></td>
</tr>
<tr>
<td>Distributes OFDA2000</td>
<td>Bill Johnston, WA</td>
<td>08 9418 8500</td>
<td></td>
</tr>
<tr>
<td><strong>Livestock Recording Australia</strong></td>
<td>Phil Wooster</td>
<td>02 6772 5316</td>
<td><a href="http://www.livestockrecording.com.au">www.livestockrecording.com.au</a></td>
</tr>
<tr>
<td>Internet based livestock recording and feedback system.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Macro Stock New Zealand</strong></td>
<td>Bob Girvan</td>
<td>64 3 307 8053</td>
<td><a href="http://www.macrostock.com">www.macrostock.com</a></td>
</tr>
<tr>
<td>MacroStud pedigree &amp; performance recording, MacroWeigh to monitor production throughput of the finishing or feedlot enterprise, MacroFleece program to record, analyse &amp; sort fleece data.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Practical Systems</strong></td>
<td>Dale Curtis</td>
<td>02 6772 6672</td>
<td><a href="http://www.psystems.com.au">www.psystems.com.au</a></td>
</tr>
<tr>
<td>Farm management software</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Riverina Wool Testers</strong></td>
<td>Paul Cocking</td>
<td>02 6925 1407</td>
<td><a href="http://www.wooltesters.com.au">www.wooltesters.com.au</a></td>
</tr>
<tr>
<td>Farm Grid® software for clients to recall and view results</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Sapien Technology</strong></td>
<td>Robert Wyld</td>
<td>0427 790 212</td>
<td><a href="http://www.sapien.com.au">www.sapien.com.au</a></td>
</tr>
<tr>
<td>SuperKool software data collection and herd management software</td>
<td>Russell Cranston</td>
<td>0418 780 779</td>
<td></td>
</tr>
<tr>
<td><strong>Saltbush Agricultural Software</strong></td>
<td>Cory Wilson</td>
<td>02 6773 3310</td>
<td><a href="http://www.saltbush.une.edu.au">www.saltbush.une.edu.au</a></td>
</tr>
<tr>
<td>Farm management software</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Industry contacts

### Weighing and drafting equipment

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Contact</th>
<th>Phone</th>
<th>Web address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boontech</td>
<td></td>
<td>03 5424 6300</td>
<td><a href="http://www.boontech.com">www.boontech.com</a></td>
</tr>
<tr>
<td>Gallagher Australia</td>
<td>Ruddweigh electronic weighing and drafting systems</td>
<td>Mike Hemsley</td>
<td>0448 494 445</td>
</tr>
<tr>
<td>Iconix</td>
<td>Electronic weighing systems</td>
<td>Murray Adamson</td>
<td>64 3 4372 548</td>
</tr>
<tr>
<td>Peak Hill Industries</td>
<td>Crates and handlers</td>
<td>Bill Byrne</td>
<td>02 6869 1700</td>
</tr>
<tr>
<td>Prattley</td>
<td>Electronic scales, crates and drafters</td>
<td>Graeme Ward</td>
<td>64 3 615 9545</td>
</tr>
<tr>
<td>Racewell</td>
<td>Electronic scales, crates and drafters</td>
<td>Ian Brewer</td>
<td>04 0533 0702</td>
</tr>
<tr>
<td>Thomson Longhorn</td>
<td>Electronic weighing and drafting systems</td>
<td>Byron Wolff</td>
<td>07 4666 6174</td>
</tr>
<tr>
<td>Thunderbird</td>
<td>Electronic weighing and drafting systems</td>
<td>Paul McMurtrie</td>
<td>0427 023 600</td>
</tr>
<tr>
<td>Tru-Test</td>
<td>Electronic weighing systems</td>
<td>Helpdesk</td>
<td>1800 641 324</td>
</tr>
</tbody>
</table>
Industry contacts

Breeding and genetic services

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Contact</th>
<th>Phone</th>
<th>Web address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meat and Livestock Australia</td>
<td>Richard Apps</td>
<td>02 6773 2948</td>
<td><a href="http://www.sheepgenetics.org.au/merinoselect">www.sheepgenetics.org.au/merinoselect</a></td>
</tr>
<tr>
<td>Lambrain and MerinoSelect Sheep genetics services</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Breeding Services</td>
<td>Allan Casey</td>
<td>02 6391 3812</td>
<td></td>
</tr>
<tr>
<td>Sheep genetics services</td>
<td></td>
<td>0408 279 719</td>
<td></td>
</tr>
</tbody>
</table>
# Industry contacts

## Testing services

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Contact</th>
<th>Phone</th>
<th>Web address</th>
</tr>
</thead>
</table>
| **Australian Fibre Testers**  
In-lab testing using Laserscan | Lorraine Hewitt, WA  
David Rolfe, Qld | 08 9641 2111  
07 4654 8183 | aft@bbnet.com.au  
aft_qld@bigpond.com |
| **Cousins Merino Services**  
In-lab fibre testing using OFDA2000 | Paul Cousins | 08 8892 2108 | www.cousinsms.com.au |
| **Microdyne**  
Hand held fibre testing device | Carmel Tinkler | 07 5594 6200 | www.woolview.com |
| **Micron Man**  
| **Interactive Wool Group**  
OFDA2000 wool testing instrument | Richard Manning | 02 6766 3077 | www.i-activewool.com.au |
| **Riverina Wool Testers**  
In-lab, in-shed and on-farm fibre testing using Laserscan | Paul Cocking | 02 6925 1407 | www.wooltesters.com.au |
| **Riverina Fleece Testing** | Val Parks | 02 6026 0551 | rftsbest@dragnet.com.au |
| **Laserwool**  
OFFM Laserscan services | Bill Harris | 02 6778 4593 | laserwool@gpo.com.au |
## Industry contacts

### Muscle and fat scanning

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Contact</th>
<th>Phone</th>
<th>Web or email address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roy Addis</td>
<td>08 9829 1013</td>
<td><a href="mailto:radar@treko.net.au">radar@treko.net.au</a></td>
<td></td>
</tr>
<tr>
<td>Tamesha Gardner</td>
<td>08 9832 8128</td>
<td><a href="mailto:stocksmart@bigpond.com">stocksmart@bigpond.com</a></td>
<td></td>
</tr>
<tr>
<td>Kate Gill</td>
<td>02 6777 9133</td>
<td><a href="mailto:kate_mag@hotmail.com">kate_mag@hotmail.com</a></td>
<td></td>
</tr>
<tr>
<td>Ian Kyle</td>
<td>03 5157 7579</td>
<td><a href="mailto:ian@primescanaustralia.com.au">ian@primescanaustralia.com.au</a></td>
<td></td>
</tr>
<tr>
<td>Alan Luff</td>
<td>02 6342 3708</td>
<td><a href="mailto:luffalan@allstate.net.au">luffalan@allstate.net.au</a></td>
<td></td>
</tr>
<tr>
<td>John Lehmann</td>
<td>08 8893 4034</td>
<td><a href="mailto:john@pollville.com.au">john@pollville.com.au</a></td>
<td></td>
</tr>
<tr>
<td>David Mitchell</td>
<td>08 9881 3881</td>
<td><a href="mailto:mitchvet@wn.com.au">mitchvet@wn.com.au</a></td>
<td></td>
</tr>
<tr>
<td>Peter Moore</td>
<td>08 9885 1461</td>
<td><a href="mailto:scanwest@wn.com.au">scanwest@wn.com.au</a></td>
<td></td>
</tr>
<tr>
<td>Steve Milne</td>
<td>03 5578 6327</td>
<td><a href="mailto:milne@bordernet.com.au">milne@bordernet.com.au</a></td>
<td></td>
</tr>
<tr>
<td>Chris Parker</td>
<td>03 5599 2477</td>
<td><a href="mailto:parkers@bordernet.com.au">parkers@bordernet.com.au</a></td>
<td></td>
</tr>
<tr>
<td>Bill Pearce</td>
<td>02 6785 1389</td>
<td><a href="mailto:alexia73@bigpond.net.au">alexia73@bigpond.net.au</a></td>
<td></td>
</tr>
<tr>
<td>Steve Parker</td>
<td>03 5599 2476</td>
<td><a href="mailto:longford@ansonics.com.au">longford@ansonics.com.au</a></td>
<td></td>
</tr>
<tr>
<td>Trevor Pearce</td>
<td>02 6383 3847</td>
<td><a href="mailto:tpss@bigpond.com">tpss@bigpond.com</a></td>
<td></td>
</tr>
<tr>
<td>Stefan Spiker</td>
<td>03 5573 3201</td>
<td><a href="mailto:als@ansonics.com.au">als@ansonics.com.au</a></td>
<td></td>
</tr>
</tbody>
</table>
Other direct points of contact are:

Kevin Atkins  
Sheep CRC Project Leader  
NSW Department of Primary Industries  
T 02 6391 3816  E kevin.atkins@dpi.nsw.gov.au

Cheryl Pope  
Livestock Officer - Precision Sheep Production  
NSW Department of Primary Industries  
T 02 6391 3948  E cheryl.pope@dpi.nsw.gov.au

Phil Graham  
Livestock Officer  
NSW Department of Primary Industries  
T 02 6226 2199  E phillip.graham@dpi.nsw.gov.au

Steve Semple  
Livestock Research Officer (e-sheep)  
NSW Department of Primary Industries  
T 02 6391 3881  E steve.semple@dpi.nsw.gov.au

Jessica Richards  
Livestock Research Officer  
NSW Department of Primary Industries  
T 02 6391 3871  E jessica.richards@dpi.nsw.gov.au

Visit the Sheep CRC website: www.sheepcrc.org.au

This site has links to industry and staff contacts, from suppliers and specialist manufacturers, to those working with PSM in the field.

Sheep CRC staff have been instrumental in identifying, evaluating and communicating to industry information on software, hardware and service providers for precision sheep production, as well as providing service support for contractors and consultants.

Specialist advisors and commercial service providers are being trained by the Sheep CRC through its MasterClass program in 2007-08.

The information contained in this publication is intended for general use only. Care is taken to ensure accuracy, however, the Cooperative Research Centre for Sheep Industry Innovation (Sheep CRC) cannot accept responsibility for the accuracy or completeness of the information. Readers are advised and must be aware that the information contained in this publication may be incomplete or outdated, for use in specific situations. Before taking any action or decisions based on the information in this publication, readers should seek expert professional, scientific and technical advice. The Sheep CRC is a joint venture between leading sheep research, education and industry organisations that was established in 2006 to conduct, coordinate, undertake and disseminate research and analysis in sheep production science and technology and to improve the competitiveness of the Australian sheep industry.